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Absiract

Ax 1t is might be aware of, turbochargers display what is known as lag time which is
the time needed for the turbine to reach its full throttle from an intermediate
rotational speed state. The duration of a wrbacharger’s lap depends on many factors
among which its inertia, airflow efficiency. back pressure, ete. 1)

Duning lag time the engine is much less responsive amd its output well below
nominal. To counter the effect of the turbocharger's lag time drivers used to
anticipate the engine's reactions hy accelerating well before they would have dane in
4 nan-turho car, Others have used a techmigue known as "left foot braking” where the
driver uses his lefl fool to brake the car while his right foot aceelerates to keep the
turbocharger in optimal load. Left foot braking is very hard on the brakes which are
put into extreme stress but is very efficient in keeping the turbo spinning.

The anti-lag turbocharger system is a technique that allows turbocharged engines to

minimize the lag of the turbo in certain situations. As you all probably alrcady know.

virtually all turbochargers out there have a "condition” whichdoesn'l let them provide
their maximum amount of pressure at lower revolution.

50 hy this system turbo lag will almost completely disappear. since this systemworks
with the turbocharger toprovide large amounts of hoost pressure and higher
volumetric etficiency ar acceleration.
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LIOverview

i simple terms, a turhocharger consists of a mrbine and compressor connected by a common
S supported on a hearing svstem.

T5e mrbocharger converis wasie coergy from exhaust gases into compressed air, an pushes it
W e engine. This allows improving cfficieney of the combustion process, increasing power of
e enmine.

S0 by the system we want to design it, the turbo lag will he significantly reduced, since this

s works with the turbocharger provides large amounts of boosts pressure and higher
sstmmetnic ciliciency at acceleration.

= Backgrounds of the project:

This system consists of mechanical and electrical components like compressors, air tanks,
mesocontroller . ... Eic,

The wse of these components is o use them to help the turbocharger to rise 1o reduce turbo
=

THes operating [unciion depends on the air pressure which can the turbo produce, so, by
e & compressed air W be produced in the engine manifold ant turbo lag can be produced,
Weh belps the turbo in increasing the inertia of the turbine which means high air pressure can be
=millecied




1.3 The budget for the project

Table (1.1) Actual budget table for the project

- Electronic actuators 3 300 G0

- Pressure sensors y: 300 600
. Pressure lanks 2 100 200

- Compressor 1 150 150
Microcontroller (PIC) | 1 80 80

1.4 The time plan for the project:

The project plan follows the following time schedule which includes the related tasks of stady
2= systemn analysis. The following time planar for the Grst semester and second semester.

The time table for the first semester is ilustrated in Table 1.1,

Table (1.2): The first semester time plan




“enie(1.3) the second semester time plan

Peesering data
Segramming the
&1C)

Tz to start the

SVsiEm

Svstem test
S=commendations
Conclusions
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2.1 Introduction;

Perhaps the best-known cogime in the world is the reciprocating internal combustion
(1C) engine. Virlually every person who has driven an aotomobile or pushed a power Lawn
mower has used one. By far the most widely used IC engine is the spark-ignition gasoline
engine as shown in figure (2-1), which takes us to school and work and on pleasure jaunts,
Although others had made significant contributions, Niklaus Otto is generally credited with
the invention of the engine and with the statement of its theoretical cycle.

Another important engine is the reciprocating engine thal made the name of Rudolf
Dicsel famous. The Diesel engine. the workhorse of the heavy truck industry, is widely used
m mdustrial power and marine applications. It replaced the reciprocating steam engine in
ratlroad locomotives about fifty vears ago and remains dominant in that role today.

The piston, cylinder, crank, and connecting rod provide the geometric basis of the
reciprocating engine. While two-stroke-cyele engines are in use and of continuing interest, the
discussion here will emphasize the more widely applied four-stroke-cycle engine. In this
engine the piston undergoes two mechanieal cycles for cach thermodynamic cycles

Push Rod et -

Valve Gear . -

Overhead
Camshaft

Figure (2-1) Internal Combustion Engines




2.2 Turbo and Super Charging;

2.2.1 Supercharger:

Supercharger 1s an air compressor used for forced induction of an internal comhbustion
engine. The greater mass How-rate provides muore oxyeen to support combustion than would
be availuble in anaturally aspirated engine, which allows more fuel to be bummed and more
work to be done per cyele, inercasing the power output of the engine. Power for the unit can
come mechanically hy a belt, gear, shaft, ar chain connected to the engine's crankshaft.

2.2.2 History:

In 1860, brothers Philander and Francis Marion Rools of Connersville, Indiana.
patented the design for an air mover, for use inblast furmaces and other industnal
spphications.

The world's first functional, actually tested engine supercharger was made by Dugald
Clers, who used it for the first two-stroke enginein 1878. Gottlich Daimler received a
Cermen patent for  supercharging an  internal combustion engine in 1885 Louis
Senault patented a centrifugal supercharger in France in 1902, An early supercharped race car
was built by Lee Chadwick of Pottstown, Pennsylvania in 1908, which, it was reported.
reached a speed of 100 mph (160 km/h).

The world's first series-produced cars with supercharpers were Mercedes 6/25/40 hp
= Mercedes 10/40/65 hp. Both models were mtroduced in 1921 and had Roots

=23 Types of supercharger:

There are lwo main lypes of superchargers defined according to the method of
Sommpression: positive displacement and dymamic compressors, The former deliver a fairly
comstant level of pressure increase al all engine speeds (RPM), whereas the latter deliver
mcressing pressure with increasing engine speed.




1) Positive displucement:

Positive-displacement pumps deliver a nearly fixed volume of nir per revolution at all
specds (minus leakage. which is almost constant at all speeds for a piven pressure. thus its
“mportance decreases at higher speeds). The device divides the air mechanically into parcels
“or delivery to the engine. mechanically moving the air into the engine bit by bit,

2} Capacily rating:

Positive-displacement superchargers are usually rated by their capacity per revolurion.
= the case of the Roots blower, the GMC rating paltern is typical. The general motor
sompany [GMC] tvpes are rated according to how many two-stroke cvlinders, and the size of

Sose cylinders. it 1s designed to scavenge.

5 Dynamic:

Dynamic compressors rely on accelerating the air to high speed and then exchanging
e velocity for pressure by diffusing or slowing it down.

=24 Supercharger drives types:

Superchargers are fither defined according to their method of drive (mechanical-or
e
&2 Mechanical:

= Bt (V-bell, Synchronous belt, Flat belt).

= Derect drive,
= Gear dnve.
= [(Ramn dnve.

&) Exhaust gas turbines (Turbocharger discussed later):

= Axial turhine
* Radial turbine [17;




P

Fipure (2-2) shows a screw supercharger and its location on the car engine

23 Turbo charger

Turbocharger is a centrifugal compressor powered by a turbine that is driven by an
smzne's exhaust gases. Its benefit lics with the compressor inereasing the mass of air entering
e enging (forced induction). thereby resulting in greater performance (for cither, or both,
sower and efficiency). They are popularly used with internal combustion engines (e.g., four-
swoke engines like Otto cycles and Dicsel eycles). Turbochargers have alse been found useful
soenpounding external combustion engines such as automotive fuel cells,

=31 History:

Forced induction dates from the late 19th century, when Gottlieh Daimler patented the
scsmgue of using a gear-driven pump Lo force air into an internal combustion engine in 18835,

The turbocharger was invented by Swiss engineer Alfred Biichi, who received a patent
= 1905 for using & compressor driven by exhaust gasses to force air into a piston
=mne. During the First World War French engineer Auguste Rateau fitted wurbochargers to
Semaalt enmnes powerng vanous French fighters with some success.

In 1918, General Eleciric engineer Sanford Alexander Moss attached a turbo to
¢ % 12 Liberty aircraft engine. The engine was tested at Pikes Peak in Colorado at 14,000 feet
£ % m) to demonstrate that it could eliminate the power loss usually experienced in internal
sesustion engines as a result of reduced air pressure and density at high altitude. General
Sectme called the svstem turbo supercharging.

Turbochargers were first used in production aircraft engines such as the Napier
omess in the 1920s, although they were less common than engine-driven centrifugal
v hargers. Ships and locomotives equipped with turbocharged Diesel engines began
Epewring in the 19208




In the aviation world, turbochargers were most widely used by the Umited States, who
led the world in the technology due to General Electric's carly start. During World War 10,
sotable examples of US aircraft with furbochargers include the B-17 Flving Fortress, B-24
Uiberator, P-38 Lightning and P-47 Thunderbolt. The technology was also used in
cxpenmental fittings by a number of other manufactiurers. notably a vanety of Focke-Wulfl
Fw 160 models, but the need for advanced high-temperature metals in the turbine kept them
out of widespread use.

2.3.2 Operating principle:

All naturally aspirated Otto and diesel cyele engines rely on the downward stroke of a
sston to create a low-pressure area (less than atmospheric pressure) above the piston in order
% draw air through the intake system. With the rare exception of tuned-induction sysicms,
=ost engines cannot inhale their full displacement of atmosphenc-density air. The measure of
S loss or inefficiency in four-stroke engines is called volumetric efficiency. If the density of
S miake air above the piston is equal to atmoespheric, then the engine would have 100%
sumetne efficiency. However, most engines [ail o achieve this level of performance.

This loss of polential power is often compounded by the loss of density scen with
sevaled altitudes. Thus, a natural use of the turbocharger is with aitcraft engines. As an
wrerafl climbs to higher altinudes, the pressure of the surrcunding air quickly falls off. At
5486 m (18,000 ), the air is at hall the pressure of sea level, which means that the engine
will produce less than half-power at this altitude.

The ohjective of a turhocharger, just as thal of a supercharger, is o improve an
enping's valumetric cfficicncy by increasing the intuke density. The compressor draws in
ambient air and compresses it before it enters into the intake manifold at increased pressure,
This results in a greater mass of air entering the cylinders on cach intake siroke. The power
needed to spin the centrifugal compressor is derived from the high pressure and lemperature
of the engine's exhaust gases. The turbine converts the engine exhaust's potential pressure
snergy and kinetic velocity energy into rotational power. which is in turn used to drive
the compressor.

A turbocharger may also be used to increase fuel efficiency without any attempt to
morease power. [ does this by recovering waste energy in the exhaust and feeding it back into
e engine intake. By using this otherwise wasted energy to increase the mass of air, it
Secomes easier o ensure that all fuel is bumed before being vented at the start of the exhaust
stzge. The increased temperature from the higher pressure gives a higher Camot efficiency,

The control of turbochargers is very complex and has changed dramatically over the
-plus years of its use. A great deal of this complexity stems directly from the control and
performance tequirements of varicus engines with which 1t is used. In general, the
s=hocharger will accelerate in speed when the turbine generates excess power and decelerate
when the turbine generates deficient power, Aircraft, industrial diesels, fuel cells, and motor-
sports are examples of the wide range of perfermance requirements. (16)




Figure (2-3) shows the main operating components
ompressor inlet (2) compressor outler (3) air intercooler (4) intake manifold
* 1 Exhaust (6) turbine inlet {7) turbine outlet,
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Figure (2-4) shows a cross section of the turbocharper

=4 Pressurc-wave Supercharger

A pressure wave  supercharger (alsa known a5 awave rotor) is a  type
¢ supercharger technolopy  that hamesses the pressure waves produced by am internal
swmbustion_cngine exhaust gas pulses to compress the intake air. Its automotive use is not
wfespread, the most widely used example is the Comprex, developed by Brown Boveri
eran fested such a device during the development of thel 26C Formula One car. The system
S ot fend itself to as tidy an installation as the alternative twin-urbocharger layout, and the
== was never raced m this form.

11




Figure (2-5) Pressure wave supercharger

Many methods have been proposed to control the load without or with reduced
Seetting. A good way to increase the overall efficiency of an engine-vehicle system is to
wiuce the engine displacement and to use a supercharger. Today's standard supercharger is
S swrhocharger, where the enthalpy in the exhausl gas drives a compressor, which in lumn
s the pressure in the intake manifold. In a pressure-wave supercharger, one-dimensional
peady zas dynamical effects are used fo transmit the enthalpy in the exhaust gas to the
=i e =1 by short-time direct contact of the Huids in narrow flow channels.

H

Modemn pressure-wave supercharging devices oller set the gas pockel valve, the cell-
wiee speed, and the offsel between air and gas casing as shown in figure (2-6). A multitude
¢ soes-couplings towards the mass flows and, in particular, (0 the enmne lorque can he

e therehy
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Combustion
chamber
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Figure (2-6): Pressure-wave supercharged engine system structure

2.5 Turbocharger time delay (turbo lag):

Turbo lag is the time delay of boost response afier pushing on the accelerator pedal
% oen operating above the boost threshold engne speed. Turbo lag 1s determined by many
Secors, including turbo size relative to engine size, the state of tuning of the engine, the
et of the turbo's rotating blades, turbine cfficiency, intake plumbing losses. exhaust

Secio=cssure, efic,

Buost threshold is the engine speed at which there is sufficient exhaust gas flow to
generate positive manifold pressure, or boost,

13




Accelaratar pedal
position

Time

Figure (2-7) shows turhocharger time delay
Red line without applying anti lag svstem

Blue line with applying anti lag svstem

The project idea is to inject air previously compressed and stored in an air tank. By
opening the flow of this air under a measured pressure under the conditions that make a delay
for the turho charger.

So. sensors and actuators gre going to be needed, microcontroller as an Electronic
Control Module (ECM), air pressure tanks and there will be an indirect interface between the
mucrocontroller and the cars injection sensors.

The compressor is going to fill the tanks with a compressed air under a constant
pressure . there will be a pressure sensor on the air tanks measured the pressure of the air
mside the tanks and send it as a signal (o the microcontroller | when the pressure rises to the
specific pressure the microcontraller stops the work of the compressor and when there is
going to be a time delay in the wrbo sends an clectnie signal 1w a valve acruator which it is
occupied on the outlet of the compressar which to fill the pressure of the turbo which has
Been delayed.

14




26 Pneunmatic:

Pneumatics is a branch of technology. which deals with the study and application of use
of pressurized pas Lo effect mechanical motion.

Pocumatic systems are extensively used in industry, where {aclonies are commonly
plembed with compressed air or compressed inert gases. This is because a centrally located
=nd  electrically powered compressor that powers cylinders and other pncumatic  devieces
Swough solenoid valves is often able to provide motive power in a cheaper, safer, more
flexible, and more reliable way than a large number of electric motors and actuators. 115

And the pneumatic components in this system consist of:

{1) Compressor.
2) Electrical actuators,
(3) Sensors.

(4) Adr tanks.

2.6.1 Air Compressor:

An air compressor is a device that converts power (usually from an electric motor, a
diesel engine or a gasoline engine) into kinctic cnergy by compressing and pressurizing air,
which, on command, can he released in quick bursts. [14)

Types of compressors:

As shown in Figure 4, there are lwo basic compressor lypes: positive-displacement and
dynamic, In the positive-displacement type, a given quantity of air or gas is irapped in a
compression chamber and the volume it occupies is mechanically reduced, causing a
corresponding rise in pressure prior Lo discharge.

At constant speed, the air flow remains essenhally constant with variations in discharge
pressure, Dhynamic compressors impart velocity enerpy to continuously flowing air or gas by
means of impellers rotating al very high speeds. The velocity energy is changed inlo pressure
energy both hy the impellers and the discharge volutes or diffusers.




| Redprocatin Rotary Centifugal il

Figure (2-8) Types of Compressors

Ivpe of compressor 1s going to be used in this system is & Positive Displacement
Compressor. These compressors are available in two types: reciprocating and rotary,

1) Reciprocating compressor:

A reciprocating compressor or piston compressor as shown in figure (2-9) is a positive-
displacement compressor that uses pistons driven by a crankshali o deliver gases at high
PTEsSUre,

The intake gas enters the suction manifold, then flows inlo the compression cylinder
where it pets compressed by a piston driven in a reciprocating motion via a crankshaft, and is
then discharged. Applications include Oil refinerics, Gas pipelines, chemical plant
natural gas processing plants and refrigeration plants. (13

IFITAXE EXHAULT
VAIVE WALVE

Figure(2-9)
16




2} Rotury Screw Compressor;

A rolary screw compressor as shown in figure (2-10) is a type of gas compressor which
“ses a rotary lype positive displacement mechanism. They are commonly used to
eplace piston compressors where large volumes of high pressure air are needed, cither for
wrge industrial applications or 0 operate high-power air tools such as jackhammers.

The gas compression process of a rotary screw is o continuous sweeping motion, 5o
Sere s very little pulsation or surging of flow, as occurs with piston compressors, (1)

Discharge
Disch Yalve
PN:F { Chuteh
> 1)
gl I
Sl Pumnp
— Yane
ol
Fleser wuir G
Rotor Boady

Fipure (2-10)

2.6.2 Pressure valve solenoid!

A solenoid is an eleciromechanical dewvice which allows for an clectrical device to
control the flow of a gas or liquid. The electrical deviee causes a current to flow through a coil

17




‘wcated on the solenoid valve., This current flow in tumn resulls i a magnetic field which
causes the displacement of a metal actaator.

The actuator is mechanically hinked to a mechanical valve inside the solenoid valve,
I8¢ valve then changes state, either opening or closing to allow a liquid or gas o either flow
frough or be blocked by the solenoid valve. A spring is used to return the actuator and valve
Sack to their resting state when the current flow is removed,

Solenoid valves comc in various configurations and sizes. Solenoid valves can be
sormally open, normally closed. A normally open solencid valve allows a liquid or gas to
Sow through unless a current is applied to the solenoid valve. A normally closed valve works
= the opposile manner; Figure (2-1 1) shows the solenoid valve. 11

Figure (2-11)

l. Valve Body 2. Inlet Port 3. Qutlet Port 4. Cail / Solenoid

5. Coil Windings
& Lead Wites 7. Plunger 8. Spring 9. Orifice 110y

L] 'S
P Fe

“#M“mm*

Figure {2-12) A solenoid valve is normally elosed (abbreviated - NC) if there is no
flow across the valve in its resting position (with no current on the
solenoid contacts). And its symbeol. (1)

e TR




=53 Pressure sensor:

A pressure  sensor measures pressure, typically of gases or liquids. Pressurc is an
“ipression of the force required to stop a fluid from expanding, and is usually stated in terms
& force per unit area. A pressure sensor as show in Figure (2-13) usually acts as a transducer:
* ecaerales a signal as a function of the pressure imposed. For the purmposes of this article,

such a signal is electrical.

Pressure sensors are used for control and monitoring in thousands of evervday Such as
Sl gas flow, speed, water level, and aliitude, applications Pressure sensors can also be used
W indirectly measure other variahles, 19

Figure (2-13)

~8.4 Air pressure tanks:

The tanks must be designed to safety standards appropriate for a pressure vessel as
o in the figure (2-14),

e storage tank may be made of:

- el

= Alaminum,

= Carbon fiber,
= Keviar,

= Uaber matenials or combinations of the above,

e fiber malerials are considerably lighter than metals but gencrally more expensive.
W tanks can withstand a large number of pressurc cycles, but must be checked for
ssmmsion periodically. 7




HTS-24

Figure (2-14)

=7 Microcontroller (PIC 18F4550):

The PIC1¥F4550 family member come in different packages, such as DIP (dual in line
swckeee).QFP (quad flat package), and LLC (leadless chip carrier). They all have many pains
e are dedicated to various functions such as 'O, ADC, timer, and interrupts, Note that
Weechip provides an 18-pin version of the PICT 8 family with a reduced number of /O ports
S less demanding applications. Because the vast majority of developers use the 40-pin chip,
Sewever, we will concentrate on that. Figure (3-11) shoes the pins for the PIC18F4550,

MCLAAPRES o1 S ap [ =—= ARPKBILPGD
RADMARD -—e] 2 a9 [ =—s= ARBSHBIZPGEC
RA1ARNT =—=[] 3 a8 O =— ABSHABNMGM
FRAZANZVAEFCVAEF =—a[] a 37 ] =—= REA/AN11/KBNICESPR
FATAMINGEF: = =[] 8 ag REvANECCrEhven
AALTOCKICIOUTRCY =[] 6 35 ] = REZANBANTZNVMO
B ANASEHLVDINGZOUT ~—[] 7 34 [ =—= ABVANIOANT VESGHRSCL
REQIAMS/CKISPE =—[| B w o 33 [J == RBOANIZINTHFLTO/SDUSDA
REUANB/CKIEPP ==& e 32 0 — voo
RELANTIOESPP —=—=[] 10 E E L] Ves,
Voo =1 o5 o3 30 [l == RDWESPPT/PID
VES . []12 o0 20 [] == RDE/SPPEPIC
CECUELKI —= ] 12 EE 28 [ =—= ROSSEPFPI/F1B
OSCRCLKOARAE =—0 ] 14 27 [ =—= ROASFPa
HCOTIOSOTIICK ——[] 15 26 [ =—= RCIRXOTS00
SCOUMIOSICEF'YO0E = 18 25 [ =—— RCETHCK
RE2CCP1/PIA "_"'E 17 28 [ =——— TP
Vs =-—s[] 18 o [ - R4
RACO/SPP0 -— =[] 18 gp [ =—= ROEPP3
ADM/SPP1 =——=[] 20 2i [1 =—e BD2EPP2

Figure (2-15)




Examimng Figure (2-15). note that of the 40 pins. a total; of 33 are set aside [or (he five
sorts A, B, C, D, and E with their alternate functions. The rest of the pin is designated as
Viad, GND (Vss), DOSCL, 0O8C2, and MCLR (master clear reset). Next, we describe the
Sanction of each pin, Vdd (Vee).

Tow pins are used to provide supply vellage 1o the chip, The typical voltage source is
=3V, Some PIC1BF lumily members have lower voltage for Vdd pins in order to reduce the
moese and power dissipation of the PIC system. We can choose other options for the Vdd
voltage level by selting the bits in the configuration register.

Ves(GND) :

Two pins are also used for ground. IN chip with 40 pins and more, it is common Lo have
muluple pins for VCC and GND. This will help reduce the noise (ground hounce) in high-
Sequency systems,

The PICISF has many options for the clock source. Most often a quartz crystal
secillator 1s connected to input pins OSC2. The quartz crystal oscillator connected to the
U501 and OSC2 pins also needs to capacitors. One side of cach capacitor is conmected to the
sound . Note that PIC|8f microcentrollers ean have speeds of OHz to 40 MHz, We can
choose options for the clock frequency by selling bits in the configuration repister.

MCLR:

Pin 1 (in PICIBF4550 40-pin DIP) is the MCLR (master clear reset) pin, Il is an input
e=d 15 active-LOW (normally HIGH). When a LOW pulse is applied to this pin, the
microcontroller will reset and terminate all activities.

Ports A, B, C, D, and E:

As shown in Figure (3-14), the ports PORTA, PORTB, PORTC, PORTD, and PORTE,
e 2 total of 33 pins. All the ports upon RESET are configured as input, because TRISA —
TRISE have the value FFI on them.

PORT A:

Port A occupies a total of 7 pins (RAQ RA6), but for the PIC18F4550, pin A6 is used
S the OSC2 pin. AG is not available f we wse a crystal oscllator o grovide freauency 1o the
FICI8 chip, To use the pins of port A as both input and output ports, each bit must be
comnected externally to the pin by enabling the bits of the TRISA register.
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FORT B:

Port B occupies a total of 8 pins (RBO_RB7). To use the pins of port B as both inpul
&=d ourput ports, each bit must be connecled externally ta the pin by enabling the bits of the
measter TRISB.

PORT C:

Port C occupies a total of 8 pins (RCO_RC7). To use the pins of port C as both input
and output ports, each bit must be connected externally to the pin by cnabling the bits of the
regster TRISC

PORT D:

Port D occupies a total of 8 pins (RD0_RD7). To use the pins of port D as both input

#nd outpul ports, each hit must be connected externally to the pin by enabling the bits of the
register TRISD.

PORT E:

Port E occupies a total of 3 pins (REQ_RE2) in PIC18F4550. Port E is used for 3
sdditional analog inputs or simple 1'O: ANS, AN and AN7. Just like other ports, Port E has
stemmate functions.




Chapter

Three

Design and Calculations
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.1 V-belts and pulleys:

Introduction:

Accurate alignmenl, the correct groove profile for the V-belt and an appropriate belt
wn are vital for the driving mechanism to function properly, The eccentricity values

“ed by the V-bell manufacturers are maximom values determined under specific
semstances.

Sxperience has shown that when fitfing compressors to diesel engines, these eccentricity
= can be excessive. The v belt can be expanded and be destroyed prematurely, For this
= the eccentricity should be kept as small as possible. Narrow V-belts are preferably used in
=3l engineening and in the motor vehicle industry.

& V-belt drives, the increased friction achieved by the V-shaped proove is utilized. The
% of the Oued V-belt very effectively transmit the energy through their adherence friction
sk practically without slipping, If properly designed. the efficieney of V-belt drives is

San 95 %. It is important that through the use of narrow V-belts. very small eccentricity
=5 can be selected.

e eccentricity A should remain within predefined limits, i.c. if should be larger than 0.7
= &w) and smaller than 1.5 (Dw + dw),

Fandamentals for the utilization of V-belts:

ke sure that the driving mechanism receives V-belts of the right number, type and size for
smplacation.

Setore you mount the V-belt pullevs, make sure that the grooves are free of
. rust and dirt.

S the V-helt on hy hand without using any excessive force and at the smallest possible
=e=aty - without the use of any mechanical implements.

A wv-belt drive lor a-cylinder diesel engine powered a compressor, asswne this engine
=2 over 15 hours a day at 3000 rpm, where it develops 90 hp. the driven speed is 2000 rpm,
W space limitations the desired center distance must be around 0.90 meter.
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2.2 Alir tank design:

e receiver volume may be calculated with the formula
E=V{p:-p2) /' C p, (3-1)
wEere
+ = wolume of the receiver tank (cu (1)
© = ume for the receiver to go from upper to lower pressure limits (min)
= free air needed (scfm)
%~ smusphere pressure (14.7 psig)
= maximum tank pressure (psia)

= munimum lank pressure (psia)

& also common to size receivers

= | gallon for cach ACFM (Actual Cubic Feet per Minute), or
< gallons per compressor hp (horse power)

volume(Veng)= 2000 em"3=2(litre).

e tank volume = 10(litre),

s = minimum pressure = 3 bar = 300(kpa).

= maximum pressure = 12 bar = 1200(kpa).

= gimospheric pressure = 1bar = 101(kpa).

1o supply the engine with air at 3000 rpm, we will first calculate swept volume of the

gt 1), *N2 (3.2)

gwept volume.
sumetric efficiney(20%).




engine speed(rpm).

2% 20%(3000/60)2
= 10 (litre per second).

_to find the time:

= P * t*Vaw/( Pmax-Pmin) (3.3)
= 10T*1073%c*10/(1200-300)* 103
= 10

= 3 (second)

ssismetric efficiency caleulation:

B =2"mal( p *Vd*N) (3.4)
2=P/RT (3.4)
PV=mRT (3.5)
Where

S stimospheric pressure=101 (kpa).
¥=gas constant— 0.287 KJ/Kg K
U= temperature of surrounding air = 25 c=298k.
= turbo pressure=2.3 bar= 230 kpa.
=40c=313k
=e=PV/RT

= 230*1896/0.287%315

= 04853 pevele.
B 2%0.4853%720)/(1.181*1896*3000)

=20%

23 Turbocharger Mass Moment of Inertia:

Changes in turbocharger rotating inertia GTC have been found to have the strongest
wfuence on the rotational speed response; it is not surprising then that turbocharger
sanufacturers try to design for the lowest possible inertia.

This can be achieved by adapting lighter materials, e.g., titaninm aluminide (TiAl), or
cerzmic ones such as silicon nitride, in order to decrease the turbine rotor mass, this is the most
srughtforward lechnigue since it does not inflluence the turbine nozzle area; hence steady-state
Speration remains unaltered.

Most of the mrbocharger inertia (70% or even more) is twpically associated with the
seroine wheel owing to the high density material with respect to that of the compressor impeller,
! large diameter compared with the shaft. The mertia of the turhocharger disc is proportional
W the fourth power of diameter, but since tip width and rotor length tend Lo increase with
Sameter, turbine mertia 1s more closely related to the ifth power of diameter, 1.6 5 GIC o |
This suggests that reducing turbine (and compressor) rotor diamerer will strongly mfluence
swbocharger and, conseguently, engine speed response, albeil at the expense of turbocharger
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cfficiency. Hopefully, as diameter is reduced, the penalty in efficiency changes much more
slowly than nertia

By reducing the turbo-machines diameter, hence turbocharger inertia, faster acceleration
of the turbocharger shaft is established; the higher achieved rotationalspecd moves the
compressor operating point towards higher boost pressure and airmass flow-rate values, The
mereased air-supply to the engine cylinders minimizes the fuel limiter's function, thus allowing
migher amounts of fucl to be injected
Without fear of smoke emissions.

Turbovharger acceleration is significantly nfluenced by changes in inertia. This affects the
subsequent engine response via the fuel controller. Thus at the 1 s point, the lowest inertia
wurbocharger has developed a pressure ratio of 1.4, allowing the fuel controller to inject more
“u¢l. This enables the engine to continue accelerating rapidly.

Combustion deterioration cannol be totally prevented, but the much smaller duration of the
wrbocharger lag ensures a smoother response and lowers soot emissions during the carly cyeles
of the rransient event. It should be noted, however, that a very low turbocharger inertia may,
nder some crrcumnstances (e.g, depending on the specific govemnar characteristics), lead to an

ssaillatory engine recovery, which is unacceptable both in rerms of recovery time and crankshaft
STEss.




]
L]
|

5 | Ty U
3 B o
24—
/ i f
R
£ 46 .;’ v
g " (L -~
B R
o8-~
15—
=
5 ~
:T,‘D—"[“
IR B
. - ——

L s 05 . ::-.—,:-_:‘:'_— = -
3 T
(V7]

00—
60,000 —

.
I
<

N

8
:
|

X

3

— = = - 42% Turbocharger Inertia
—————— 100% Turbocharger Inertia
— 170% Turbocharger Inertia

Turbocharger Speed (pm)
.
N

8 o
|
|

J.'!._ _'_',.-: -L___:;? _:\:__-_ i

3
|

&8
|

i
\

Fuel Pump
Rack Position (%)
\

:
|

- — -— - - — e

Engine Speed (rpm)

| A I : | o i
2 4 & & 10 12
Time (5)

Figure (3.1) Effect of wrbocharger moment ol inertia (same frame) on propeller law engine
acceleration of a highly-rated turbocharged dicsel engine. 121




Chapter

Four

Control




4.1 Introduction

Movement of ditferent parts of the device, or even movements of the human body are
meamngless and useless without control to serve the purpose and objective of this movement.

This coneept is clear from the meaning of conrrol is to reach the intended target of the
movement.

And in order for the control system must have important things ro explain in the
following figure (4-1).

Input Process or Output
Plant

Feedback ]*—

Figure (4-1) shows flow chart without controller

Figure (4-1) represents the main components of control operations, the si tmal i3 given
al the input and then processed and sent 1o the output and retlumns u signal through the
feedback for comparison with the input and when the feedback signal is equal with the input
this means that the target is reacled.

Feedback

Process or Output
Plant

)
J

Figure (4-2) low chart represeats the svstem with controller




Figure{4-2) represents anather image to control is that for cvery system has equations
of motion of 1ts own based on its physical characteristics including the weight of the system
and moment of inertia, natural frequency. and things vary according to the system and fhese
squations fixed. they cannot change equivalents to  achieve the desired goal (because
the coefficient of any change means change in the system) so they are working to introduce
the concept of the controller through which they can change the roots of equations of the
syslem and thus control the response of the system and speed .

In this project they used a feedback control to connect the output signal from the
sensors, and make the operation of the signal and compare them with the save real value
{ saved in the microcontroller),and depended for this value the microcontroller get the output
sigmal .

It 18 not intended to go into thedctails of more complex system because our
project does not require this complexity, it can reach the desired goal without resorting to
more complex systems.

4.2 Ilow to control:

Process control is  performed through  the received data input trom the system  and
gicdl caleulations through the program stored in advance and then output the data fit with
e mput of the system,

This 1s done through the controller where the controller is working to coomdinate the
functions of parls of the program through its own as it should be noled here that there is to
prepare many types of controllers but we have chosen to mierocontroller (PIC18F4550) this
project for several reasons includimg:

L. The availability of an (MPlab) through which the writing of the program and upload il w the
controller.

2. It contains timers and counters, digital and analog inputs and outpuis. As well its high-
speed that allows to use it in very our project,

3. Available in the local market.

4. Knowledge, we have studied theoretically and practiced PIC programing throughout our
study at PPU
3. The cost




e following figure (4-3) shows the inputs and outputs of the controller.
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Figure (4-3) shows the inputs and outputs of the controller

The program is stored on the controller memory and you must make sure that each
pin 18 connected to the programmed position.

Figure (4-4) shows the programmer
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4.3 Sensors

Sensors collect information and convert it to the controller, to the data sheet for the
sensor we can find a relationghip berween inputs and outputs for sensor, these relations are
stored in the program of controller to be used properly und required in the project

In this project three sensor, where used to mcasure the input variables and send signals to
the controller. These sensors are:

| Pressure sensors

Range (50...600 kpa), (0...53 V)

Figure (4-5) pressure sensar 66 0 281 002 420

P: WFa

Figure (4-6) shows the relation hetween pressurc and voltage

From the liner relation between pressure and voltage we find the slop value

S= AP/AV = (P-P1)/ (V-VI])

4.1)
BB 1= (P2-PINV-VI)(V2-V1) ;
P= ((P2-P1)(V-V1){(V2-VI))+P1

Bur, N= 2710 [(Vrelt - Viref-)




Precision; if N=1, dVin= (Vreft - Vref=)/1023

V=N*(5/1023)

P(N)=(2750/4095)N-+0.05

2 .inductive crankshaft sensor

Figore (4-7) Inductive Crankshaft Sensor LA B 261 209 519-01)

Jojloeden

-

Figure (4-8) Signal Of Crankshaft Sensor And How To Treatment The Signal

(4.3)

(4.4)

from the cutput signal show in figurc(4-8),we find the voltage runge hetween
= 5V _- 5V),we take this signal and input to the diode to make cancellation for the nepative
egon signal , and contacted this signal to a (100 Micro Farad),and used the voltage regulator

SV to protect ( the PIC).

L
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N=2"10 {(Vreft - Vrel-)
Precision: if N=1, dVin= (Vref~ - Vref-)/1023
V=N*(5/1024)

N=1023V/5 (4.5)
3. Accelerator pedal sensor
= (40-9)APPS
Output vollage

Ln Usable Range 15.9

Accelormior Pedal Turning Angle (¢ )
T1: Accelaerator Podal Fully Relaased
=2 Accalarator Pedal Fully Depressed

From the liner relation between pressure and voltage we find the slop value

S= AD/AY = (@ - 01y (V-V1)
S01= (22- @NV-VIIV2-V])




2= ((D2- DINV-VI){VZ-V1)+ @1

But, &= 2710 /(¥ref— - Vret-)

Pregision; if N=1,dVin— (Vref+ - Vref-)/ 1023
V=N*{5/1023)

G(N)=(0.02033)N - 3.04

4.5 Denvelopment tuols

To program the microcontroller, we use tools from Microchip:

= Inlegrated Development Environment MPLAE IDE 7,31
= € Compiler MPLAB CI& Campiler vi.0
= Programmer / Debupger MPLAB ICT)2

MPLAB IDE is a user friendly interface for editing. compiling, programming and
debugging code. It supports 10D2 progrummer/debugper and C source level debugping.

A project consists in a collection of files: the main program, libraries (source to he
compiled), a linker file (with the extension i) which contains the location of the program

and the data in memory.

4.4.1 PROJECT CREATION AND MPLAB CONFIGURATION

1¥ step: How to create & folder and add the libraries from IUT Cachan

Create a working directory and copy in it the libraries (C files, gameled v3.c), vou

would like to use and the configuration file gamelinith

2™ step: How to create a project 7

Select Project>Project Wizard to create a new project. Click on next. Choose the
device (named farger also). Your microcontroller is a 18F4550.

(4.6)




Frojert Wizard

Elzn One:
el g e

Dewies
:.._. e =

[Pt [ Swven s | [ pemiet | [_ae |

Click Next, choose Microchip C18 Toolsuite compiler. The elements of the compiler
are in Toolsuite Contents. Indicate the location of each element on the hard disk:
= MPASM (Assembler): ¢:\mec] Simpasmmpasmwin.exe
= MPLINK (Linker) : ¢:'meel 8'binimplink.exe
= MPLAB C18 (C compilater) : eivmee] 8'hinimec] 8.exe
= MPLIB (Microchip libranes): ¢:'imec| 8'binimplib.exe

Pl Wizard
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Click next.
I this new window, indicate the name of your project and ils loeation on the hard disk
{Browse)
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Click next.
Add the source C files containing the functions used In your project (gameled vi.c)
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Click next and finish.
3™ slep: How to configure the compilation aptions for your project
Sclect Project>Build Options>Praject. Type the path of the header *.h Microchip files

(¢imeel Rinclude), of the already compiled library *.0 Microchip files (¢:\mec18\ib) and of
the linker * {kr Microchip files (d:\mec18\kr) as indicated below:
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To add a file to the project

The project must contains onc and only one file with the function mainy) (entrv point
of the program), To creale a new file select File>New. Then save it with the extension * ¢,
To add this file Lo the project choose praject =2 Add Files or use the right button of the

Mase.

Remarks:

- The header files mustn't be compiled and added to the project. They are just declared with
sinclude < xxx.k > if they are located in the include folder or with #inelude " xxoch " if they
are |ocated in the working folder,

- The Mplink linker, which builds your project needs a sunpt file. Select Linker Scripts with
the right button and Add Files, Look for 1845501 Ikr in e:\mecl 8\Thr.

4.4,2 BUILDING 1HE PROJECT:

Select Project>Build All to build (that 15 to sav compile and link) the project. Wamning
and error messages may appear in the outputl window (Quipur). Otherwise the messape
BUILD SUCCEEDED is displayed in this window. You may see it with Fiew>Outpur.
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443 EXECUTION anp pEBUGGING WITH MPLAR ICD 2

The geal of debugging is to check the execution of the program with the PC. This
means step by step, execution, wetching variables, and settings of breakpoints. ‘The
communication between the PC and the microcontroller is, in that case. very important; It's

managed by the debugger MPLARB ICD2 which is used also to load the program into the
microcontroller,

1" step: How to select the debugger

Select Debugger>Select Tool>MPLAB ICD 2 to choose the tool 1ICD?2 to communicate
with the microcontroller. This tool bar should appear:

P UMPPIR| e

2™ step: Connection with the microcontroller

Select Debugger>Connect or the icon

DL e S e S T _
1| ="

e B e el M s mee

PR | el Vs SLA W |
I‘-n ITEATdl e b o d e e Tt e e = = T pepy g,
S pe——

e m—r e

The results of tests are displayed m the output window. The word READY means
evervthing is OK.




-5:&

step: Programmation

To program the microeontroller select Debuggar> Pragram or the icon

M

4% step : Running the program

Select Debugger>Run, or the icon .

5 step : How to debug.

To test and correct your program you may choose the following debugping facilities :

LT {F5) o stop the execution. A green arrow is displaved in front of the instruction
which was about to be executed.

4.5 Programming and code

Programming is the most important steps in the design of the controller because it is
the language of comimunication between different parts of the machineg, so that the
svstem performs the functions assigned to it in an orderly and complementary process to
reach the desired goal.

With the presence of multiple programming languages had a C
language compatibility with most programming language controlled, the following flow chart
in Figure (4-§), where put the program based upon.




In this projeel they applied the equation in the motor without load .and when find the
villue of parameter (x, v, z) by using the multimeter they found:
1 (eutput voltage of inductive crankshafl sensor) = 2.5v
X={(2.5%1023)/5 =512
¥ ¢ {output valtage of aceelerator pedal sensor) = 4v
Y =(4.5%1023)5 = 818
2 ! (output voltage of pressure sensors) = 1.1v
Z=(1.1%1023)/5 = 225




{ “J}_‘{—“"U
| l @

Check the fuel
pedal sensor

/ open main valve
/ close solenoide valve

Figure (4-8) flow charl of system




The code:-

#include<pl 814550 h=
#Finclude<adc.h=
Zinclude” gamelinith"

void main()

{

ungigned int sensorl ,sensor2,sensord;

OSCCON=255;
ADCON1=12;

TRISBbits TRISB1=0;
PORTBhits RB1=0;

TRISDbits. TRISD3=0;
PORTDbits RD3=0;

OpenADC( ADC FOSC 32 &
ADC RIGHT JUST &
ADC 12 TAD,

ADC_INT OFF, 12):

while(1)

i

SetChenADC( ADC _CHO );
ConvertADC();

while{ BusyADC{) ):
sensor] — Read ADC();

SetChanADC{ ADC _CIT1 );
Convert ADC();

while( BusyADCY) )
sensord = Read ADC();

SetChanADC( ADC_CH2 J;
ConvertADC();

while( BusvADC() )
sensord = Read ADC();

if{sensor] =511 && sensor2=818 && sensord<225)
[
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PORTBbits.RB1=1;

PORTDbils.RD5=1;

i

else il{sensor1>511 && sensor2<818 && scnsor3>225)
{

PORTBhits RII1 =0;

PORTDhits.RD3=0,
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Appling system and results
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Introduction:

In the previous chapters we discussed the operating of tarbo supercharging, and the paris
W S anu lag in the turbo system.

And onve again the mean of turbo lag is that Turbo rely on the flow of the exhaust gas
Ssugh the lurbine housing, As the enginc RPMs increases, the turbo spoals up and starts to
Wi boost, The delay between pushing the accelerator pedal and the mrbo spinning and
wcucing boost is known as ‘turbo lag’'.

To improve best known a goad hoast, the system will be able 1o prevent that unwanted lag.
5.2 Components of Turbo anti lag system:

1.  Airinjection umit
2. Ihigh pressure air lank and mechanical pressure sensor.
3. Thgh pressue air compressor

5.2.1 Airinjection unit shown in figure (5-1)

Eamsists of*
8} Pressure sensors:

There are two main sensors, the first one reads the pressure of the manifold and
transfer it 1o the engine ECU as shown in figure (5-2),

The other sensor is connected to the controller and reads the pressures at the exit of
the turbo charger know when to inject the high pressure air to the manifold shown in
figure (5-3).
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Figure (5-2) shows the hoost pressure
SCIISOT,

Figure (5-3) shows the turbo pressure sensor.

b) Air pressure reducer:

It is located on the air injection unit and its main function is to reduce the pressure coming
som the storage tank at a pressure of 8 bar to the recommended pressure at the intake manifold
% 2 bar as shown in Ligure (5-4).




Figure (5-4) the pressure reducer

It has  pressure regulator to adjust the desired pressure and it has a pauge to know the
wssure that is been regulated.

¢) Multi-function vacuum air flap:

lts main function is to close the path between the turbo pressure and the air injection unit
» ==own in figure (5-5).




© Air injection solenoid valve:

This component takes a voltage signal from the controller to pass the pressurized air from
sank to the air injection unit then to the engine manifold as shown i figure (3-6).

Figure (5-6) shows the air injection selenoid valve and its location om the injection unit

5.2.2 High pressure air tank with mechanical pressure sensor:

It accumulates the air under & bar pressure and its volume 40 liter consists of pressure
e and pressure sensor. The pressure sensor function is to prevent pressure to increase rather
s X bar,

It cut-oul the voltage on the compressor and cut-in again when the pressure is less than 4
s
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Figure (3-7) shows the used air tank and mechanical pressure sensor

5.2.3 High pressure air compressor:

The compressor that is used is similar to the AC compressor in the car which
iow charging the air inside the tank under high pressurc and in a little tme.

Figure (5-8) shows the compressor
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53 Results;

Now by assembling all these components on a car and having a road test using a scan tool
k2 the VAG the results would be as shown:

S5:3.1  Testing the car without the system (using the normal turbo boosting):

Figure (5-9b)
g2




Figure {5-9d)

From figure(3-9) when the driver press on the aceelerator pedal 100% the boosting
wessure (manifold pressure) will be approximately 2 bar . but to build this pressure there is
“wconds in time and this delay is shown in graph(5.1).




Graph (5-1) shaws the system delay

The green line is the manilold pressure

The red line is the engine speed

From figures (93,9b,9¢,9d) the average of the mass air flow, manifold pressure and engine speed

will be:

Vass alr flow= (750+780+650+740)/4= 730 {ma/str) (5.1}
Manifold pressure= (1938+1805.4+1295.4+2091) /4= 1782.5 {mbar) 5.2)
ngine speed= (315042121+2940+3948)/4= 3029.8 (RPM) {5.3)

Tom previous graph:

The harizontal yellow line is 2 seconds or 1.3 mm {measured by a ruler), now by measuring the
“=tance of the delay between two blue vertical lines it will be 1.6 mm, to determine the time delay;

L3 mm = 2 seconds

LEmm=?7
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1.6 mm * 2 secands)/1.3 mm = 2.46 seconds is the defay of the turbo boost at normal conditions at

different road conditions.

5.3.2 Tesling the car with the svstem:

This system will prove that the delay reduced which gives better perlormance when
pressing on the accelerator pedal.

[Gal

Wit - : L

1276 fmm 000% | 000 ] N 8C
EIIFEIIH!I mlrm MM ﬂ-ﬂ#’ﬁw

ugﬁ-mﬁm
855 0mafsk | Y282 mbor | 20706mbor | 1000 %

Figure (5-10) shows measurements with system
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Now, how air mass meter technique works?

By closing une side of the air injection unit and connecting the other side with the car air
mass shown in figure (5-12) and lock at the scan toal | bv opening the air from the tank o the
anit and closing the MFF and release it, a flow will be calculated and measured gs shawn in
figure (5-11).

Figure (5-12) shows Lhe assembled air mass

S




3.4 Recommendations and Conclusion:

!} The pic must know that the compressor must start to charge the tank when the vehicle is
going downhill and that by taking a signal from the ABS (wheel speed sensorjand when the
sccelerator pedal is 0% and the gearbox is on the second or any gear,

2) Use an electronic pressure sensor located on the air tank which can determine the pressure
and send it to the controller.

31 The svstemn musl work when the vehicle is moving and the engine is on, which means that the
controller must have a signal from the ABS (wheel speed sensor) and the crankshalt sensor.

Conclusion

In the last , all the project parts has been assembled together. which it has been proved that
iz system is suitable or the engine to decreasc the time needed to build up the pressure in the
@iake manifold which seems that the system gives a perfect response and high performance
when applying the system.
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TABLE2:3:  QSCILLATOR COMEICURATION OPTIONE FOR LSS QFERATION [CONTINUED)
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